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LIMITATIONS OF WARRANTY AND LIABILITY

BATTERIES INCLUDED INC. or any dealer or distributor distributing this
product, makes NO WARRANTY, EXPRESSED ORIMPLIED, with respect to this
manual, the related floppy disk(s), and any other related items, their quality,
performance, merchantability, or fitness for any particular use. It is solely the
purchaser's responsibility to determine their suitability for any particular
purpose.

BATTERIES INCLUDED INC. will in no way be held liable for direct, indirect or
incidental damages resulting from any defect or ommission in this manual,
the floppy disk(s), or other related items or processes, including but not limited
to any interruption of services, loss of business or anticipatory profit, or other
consequential damages.

THIS STATEMENT OF LIMITED LIABILITY IS IN LIEU OF ALL OTHER
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WARRANTIES OF
MERCHANTABILITY AND FITNESS FORA PARTICULAR PURPOSE.
BATTERIES INCLUDED INC. neither assumes nor authorizes any other person
to assume for it any other warranty of liability in connection with the sale of

its products.

This manual and the computer programs on the accompanying floppy disk(s)
which are described in this manual are copyrighted and contain proprietary
information belonging to BATTERIES INCLUDED INC.

This manual may not be copied, photocopied, reproduced, translated or reduced
to machine readable form, in whole or in part, without the prior written
consent of BATTERIES INCLUDED INC.

The accompanying floppy disk(s) may not be duplicated, in whole or in part, for
any purpose. No copies of the floppy disk(s) or this manual or the listings of the
programs on the floppy disk(s) may be sold or given to any person or other
entity. Notwithstanding the above, the accompanying disk(s) may be

duplicated for the sole use of the original purchaser.

PRODUCT IMPROVEMENTS

BATTERIES INCLUDED INC. reserves the right to make corrections or
improvements to this manual and to the related floppy disk(s) at any time
without notice and with no responsibility to provide these changes to
purchasers of earlier versions of its products.

WARNING!

This manual and the programs contained on these disk(s) are

protected by International Copyright laws. Duplication by any
means, for other than personal use, is strictly forbidden and a
violation of copyright laws.

VIOLATORS WILL BE PROSECUTED!



Updates and Support

An old adage in the computer industry is that no piece of software is
ever really finished. This package is no exception. We are
committed to an on-going process of continually improving our
software.

You may find enclosed one or more loose sheets or a "Read.Me" file
on the disk containing information completed after this manual
went to press. Please be sure that you note any comments or
corrections they may contain.

It is very important that you send in your warranty card so that we
are able to advise you of any future updates and revisions to these
programs.

We believe this manual should provide answers to most any question
you may have regarding these programs. If your question needs an
immediate answer please phone our customer support number
during business hours (EST) at (416) 881-9816. If an urgent
response is not required, please feel free to write to us. A personal
reply will be issued immediately.

Batteries Included

Attn: Customer Support

30 Mural Street

Richmond Hill, Ontario, Canada
1L4B 1B5






Important Notice

TimeLink is provided on an unprotected disk. We recommend that
you immediately make a backup copy of your disk and store the
original in a safe place. Although you're allowed to make copies of
the program for your own use, you don't have the right to make
copies for anyone else. You cannot legally distribute to, or accept
copies of the program or manual from another person in any form;
printed or electronic. Please respect the copyright; many people
worked hard to publish this program for your use. Piracy makes
their efforts worthless and discourages further efforts on all our
parts.

If you are reading a photocopy of this manual, you probably don't
have a legitimate copy. Please destroy the photocopy and erase the
program copy. A legitimate copy can be purchased in many local
outlets for a reasonable price. Authorized owners get the benefit of

our customer support number, as well as our newsletter and product

updates at very low cost. Support the software publisher who
supports you: don't make or accept pirate copies.
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Our Commitment

Batteries Included (BI), is one of the oldest and largest publishers in
the software industry. We are taking the experience and knowledge
gained publishing award winning productivity software in the home
and consumer marketplace to bring you this product.

What has eight years of software publishing experience taught us?

Computer users want ease of use, both real and perceived value for
the money, quality documentation, available and responsive
customer support and above all "power", features and flexibility. We
believe we are offering a product which excells in each of these
areas.

We are not a faceless corporation. Our programmers, marketing and
support people are all committed to one goal, your satisfaction. If
there is any way in which this product, or our support staff, does not
accomplish this task, please let us know.

Michael H. Reichmann
President

Batteries Included
June 1986
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Timelink Introduction

Introduction

ST and Macintosh Owners

This manual covers versions of TimeLink for the Atari ST and the
Apple Macintosh. Both machines have very similar user interfaces, so
you should not find this approach confusing (GEM on the ST is
almost identical visually to the Macintosh OS). However, there are a
few things to note before reading the manual.

ST owners should use the left mouse button when a button click is
called for. ST owners may also size the display windows using the
lower right hand size box. Please NOTE: Any special documentation
specific to TimeLink for the Atari ST will be preceded by

(NOTE: ATARI ST). All other documentation in this manual may be
read as applicable to either the Atari ST or the Macintosh.

Make sure your time and date are correctly set in the control panel
accessory. ST owners must set the date and time each time they
boot the computer unless they have an external clock such as the
Logikhron ™ Clock Card. Macintosh owners only need to set time
and date once and the internal, battery-powered clock updates it
automatically.

In the pull down menus, the Apple icon on the Macintosh is
identical in function to the DESK menu on the ST. Other than that,
the menus are the same on both machines. Desk accessories also
differ between the two computers although in most cases their
functions are the same.

ST owners should have TOS in ROM, not on disk, and use as few
desk accessories as necessary in order to have more available RAM.
When you create a TimeLink file and exit to the ST desktop, select
that file by clicking on its icon and then select Install Application
from the Options menu. Make the file a 'TOS Takes Parameters' file
(TTP) and the associated file to load 'TIMELINK.PRG'. This permits
you to double click on the file itself to load it, rather than on the
program and then load the file.

The Macintosh version of TimeLink comes on a start-up disk but the
program files may be copied to other system disks. You can load a
file directly on the Mac by double clicking on the file icon itself.
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The ST version of TimeLink works in medium (color) or high
(monochrome) resolution but not low. If you boot up in low
resolution, use Set Preferences from the Options menu to select
medium resolution. If you have a printer attached, make sure you
have installed the printer using the proper desk accessory first.

Other differences in the machines, keyboards and computers will be
obvious or noted. The menus and options for each system are listed
in Appendix 3: Reference. Where there are any machine specific
activities, illustrations or options you will also be told.
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Why Use Timelink?

TimeLink organizes your time-related information — it is a time
management system or 'temporal database' much like an electronic
appointment calendar or datebook. It is very easy to use - the power
of TimeLink is as much in its simplicity to the user as in the
elegance and sophistication of its underlying data-handling methods.
Any piece of information can be put into TimeLink as long as it is
associated with a date or time. You can enter as much information
as you like, split it up and categorize it in any convenient way and
display any part of it on the screen. Naturally, TimeLink employs
the standard Macintosh/ST (GEM) interface - windows, icons and
mouse - in the same way as other applications programs do.

TimeLink can display your information in four different ways: by Day,
Week, Month and Year. These display windows provide various views
of the same information and update automatically whenever you
make an entry - much like making a new note on your wall-chart
year planner every time you write an appointment in your desk diary.
All you have to do is type in your entries.

TimeLink is aimed at people who need to organize and structure
their time: executive secretaries, doctors and dentists, lawyers, club
administrators, teachers, hair stylists, salespeople - anybody, in fact,
who wants to get at time-based information (appointments, events,
meetings, activities, phone calls, classes etc.) quickly and easily. It
can be used for project scheduling and management, conference,
seminar and convention planning or consulting with hourly billing
requirements. But it's not restricted to business use; it can help
organize your personal time as well. It can be an electronic diary for
individual use. Entries, of course, need not be in the future.
TimeLink is an excellent tool for keeping a record of past events as
well.

The central facilities which allow you to store and retrieve
information are supplemented by a number of useful extras. For
example, you can put numbers into the text and even distinguish
among various categories of numeric information by name (chosen by
you, of course). These numbers can be totalled over any time range.
This means that using TimeLink you can keep track of business
expenses, car mileage, time spent doing different types of work, or
work on the accounts of different clients for project management

and client billing, and so on - without having to decide in advance
what sort of information you wish to store.
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Any information in your TimeLink file can be printed out on an
ImageWriter or other printer attached to your Macintosh or a dot-
matrix printer attached to your ST. You can also send the contents
of the screen, (or the frontmost window on the screen on the Mac),
straight to the printer at any time, using the standard control-key
sequences (NOTE: ATARI ST).(Alt-Help on the ST; make sure you
have properly installed the printer first through the Desk menu
option).

Several users can all share the same TimeLink files or each person
can have their own. In multi-user situations, individual entries can
be keyed by name and only those entries with that name displayed.
Or all entries can be displayed simultaneously, depending on your
information needs. This could be in a business, a club or
organization, a classroom or a family.



Getting Started

Getting Started

All you need to run TimeLink is the TimeLink disk (Macintosh; it is
also a startup disk) or the .PRG and .RSC files (ST owners). There is
some room on the TimeLink disk for documents, but if you have an
external or second disk drive it is more convenient to use separate
data disks. Macintosh users don't have to format any disks in
advance - TimeLink uses the standard Macintosh file dialogue, which
gives you an opportunity to format any unformatted disk you may
insert. So just turn your computer on and put the TimeLink disk
into the drive.

ST users should format their data disks prior to using TimeLink and
be in medium resolution if using a color monitor.
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The icons used by TimeLink on the Mac.

The icon in the left of the box is the program itself - double-click on it to start
TimeLink running. The test file is used for data files created by TimeLink - double-
click on any data-file icon to start TimeLink and automatically open the file. ST
users also have a resource file called TIMELINK.RSC

Once you've done this, move the cursor (the arrow that moves
around under the control of the mouse) to the diamond-shaped
TimeLink icon (NOTE: ATARI ST).(ST: the icon or file named
TIMELINK.PRG ) and click the mouse button quickly twice in
succession. If nothing happens apart from the icon turning from
black on white to white on black, try again, but do the double click a
little faster.

If all is well, the screen clears to display a menu bar containing the
word TimeLink, the disk drive whirs and after a few seconds the
TimeLink menu bar appears.

TimeLink has been designed to look and act exactly like a standard
Macintosh or GEM application program. There are deliberately no
surprises in the way it works. If you are familiar with the Macintosh
and have used programs such as MacPaint (or the ST and HomeText
or 1ST Word), you should be able to use the basic features of
TimeLink immediately, without looking at the rest of the manual.
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Feel free to experiment. The only thing with which to be careful is
when using the New option in the File menu; don't create a file with
the same name as one which already exists on that disk. The system
warns you if you try to do this but if you continue, you overwrite the
existing file with a new file of the same name. This erases any data
you may have had in the old file.

You can have as many TimeLink data files as you can fit on a disk, so
as to be able to divide your information into convenient categories.

If you use a hard disk, you could conceivably fill an entire 10 or 20
megabytes with TimeLink files, if you need to! An entire company
staff's time management could be kept in a single file!

Normally you use the Open... option in the File menu to open an
existing data file, but since there aren't any data files yet, you can
now create one using the New option in the File menu.

To do this,
e move the cursor to the word File in the menu bar

¢ press the mouse button and hold it down, and move the cursor
downwards until it is over the word New.

* Now let go of the mouse button. (NOTE: ATARI ST).(ST users;
move the cursor to the menu name, then click on the menu item).
This is the standard Macintosh and GEM way of choosing a menu
item.

Desk RIICY Edit Display Telect Update Txtras

Name for new file: ' TimeLink .. 17BY SELECTOR
Test File i

Eject

| Sae | [ Cancel | | Drive |

The dialogue window which appears when you select New from the File menu.

After a few seconds of disk activity a box appears on the screen
asking you to give a name to the new file. Type in something like
Test File' (or TESTFILE.TLK on the ST), then press the Return key
(or click the mouse in the box marked Save). The disk whirs some
more as the file is created and formatted (Macintosh only; the Mac
version requires a disk formatted in a special manner which is done
by the program at this stage). Then the screen returns to its original
state.
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File Edit Display Select Update Euxtras

Test File — Thursdau Mau 22 1986 1
H Tact Eila - lllaak 21 1004 1
] Test File -~ Mau 1986 1

[fEO0=—————————=Testfile- 1986

L 1 112 [z [a]5 [6 [7 [8 2 [1o]t 11 2[13f1afis]1e]1 7[1s]i ofo]21 belala s e rrbalalofsi]
January
¥ February

March

May

| l | Aprit

June

July
August

September

Oc tober

November

Ll { December

L4

The top left corner of the TimeLink screen with all four windows open - the 'empty
appointment diary'.

To see what the 'empty appointment diary' looks like,

 choose one by one the four items Day, Week, Month and Year from
the Display menu. On the Macintosh, the four windows appear
overlapping, each one slightly below and to the right of the
previous one . On the ST, each window appears centered on the
screen in front of the last one displayed.

¢ Move the window slightly when it opens to make the one just
behind it visible until at least a part of all four windows can be seen
on the screen.

When you have finished, the 'year planner' window is at the front.
Each window has a title made up from the name of the file (and
drive:\folder\ on the ST) you are using followed by the day, week,
month or year which the window shows.
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You can move these windows around by 'dragging' in the title bar at
the top, close them by clicking in the small box at the top left
corner, and you can bring any window to the front by clicking in any
part of it, if it's behind another window. If you want to bring a
window to the front, but it's completely hidden by another window
or windows, it's easiest to just select the window from the Display
menu again. ST owners can also resize the windows by clicking and
dragging the size box in the lower right corner of the window. This
permits you to display only the immediately used area of each
window if desired. All these window-manipulation techniques are
completely standard, and are explained in detail in your Macintosh
or ST manual.
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Making Entries

Now you can make a few entries and see how they are displayed in
the various windows. To make an entry,

¢ choose Add from the Update menu. A large window appears on
top of any other windows which are currently visible, with four
text editing areas in it, marked Time, Date, Key and Text (ST: the
text box isn't marked but there is another field; Duration).

A vertical line (flashing slowly on and off on the Mac) in the Time
box is the text entry point. If you type, text appears at this point.
You can move from one entry box to the next by pressing the 'tab’
key which is near the top left corner of the keyboard (on European
Macintosh keyboards this is marked with a right arrow and a vertical
line). Or you can also use the mouse to position the cursor on
another entry box. These cursor positioning and text editing
methods fit in with the usual Macintosh and GEM way of doing
things.

(=== Ipdate ===

Add a new entry...

Time:|10-30 am | Date:[10 May 1985 | Key:[Exampl:

Text of entry:

This is an esample of a TimeLink entry.

It can contain up to 241 characters of text. You can format
the text using 'return’ characters, or use the automatic
word-wrap. This example uses both methuds.|

This shows part of the window which appears when you choose add from the Update
menu.

The Time box: put the time of day of the entry in here. Any sensible
format will do; the program is intelligent enough to make sense of
most entries. Here is how TimeLink interprets some of them:-

2:30 pm 2:30 pm - no problems here
14:30 2:30 pm
9 9 am - hours from 8 to 12 inclusive

are assumed to be in the morning.
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3.2

now

cur

Current

Making Entries

3:25 pm - hours from 1 to 7 inclusive
are assumed to be 'pm’'.

4 am - but no space needed between
'4" and 'AM', and 'AM' can be in
capitals if you like.

TimeLink gets the time from the
built-in system clock. ST users must
make sure they have set the time in
the control panel accessory first.
Whatever the 'current time' is - the
time you are looking at'. Not the
same as now'.

Same as 'cur'.

If you put nothing at all in the Time box, or the word 'day’, the entry
is marked as referring to the whole day and appears before the other
entries for that day. This is useful for events like due dates, holidays
and birthdays. As you can see, you won't have to remember any
special rules about time. TimeLink nearly always makes good sense

of what you enter.

The Date box is for the date of the entry and like the Time box
accepts nearly any understandable format. Here are some examples:-

21st September 1985
Sep 21 '85
Sept 21

9/2/86

week 12, 1985
today

yesterday

tomorrow

21st September 1985

21st September 1985

21st September, whatever the
current year is. (Not this year,
necessarily - just the one

you're 'looking at'.)

9th February 1986 - but if you have
set American date format on the
Extras menu, this is taken to be 2nd
September 1986. STusers can select
YY/MM/DD, MM/DD/YY

or DD/MM/YY date entry format.
The Monday of that week.

Takes the date from the system clock
- may be abbreviated to 'tod'. ST users
must first set the date in the control
panel accessory.

One day before the system clock -
may be abbreviated to 'yes'.

One day after the system clock - may
be abbreviated to 'tom'.
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current Takes the current date - may be
abbreviated to 'cur'.
Monday The first Monday after today. Like all

other words recognised, may be
abbreviated to the first three letters.

The Key box provides you with a useful option. If you need to keep
several different types of entry in the same file, you can distinguish
them by assigning a key of up to seven characters to each category.
For example, if you were managing the affairs of several people in an
office, you could assign each person a key consisting of their initials
or name. Events not tied to a particular person could be given other
keys, such as launch' for the date of a product launch, 'hol' for a
public holiday and so on. If you don't need to use this feature just
leave the box blank and move on to the Text box by pressing 'tab'.

The importance of the key entry comes when you want to display all
entries relating to a specific key. Then all other entries are
suppressed and only those with the requested key are displayed.

The Text box: up to 241 (ST: 511) characters of text can go in here.
This can be literally anything you want. You can format the entry
into lines by pressing the Return key at the end of a line, but if you
don't do this the text automatically wraps around when you get to
the right hand side of the text box like in a word processor.

Duration is another invaluable option available only on the ST. If you
wish to schedule a half-hour meeting and make sure that it doesn't
conflict with other appointments, enter '30 min' in this box and

when you press OK to make the entry the system automatically
checks for any conflicting entries with the same key and asks you to
confirm or cancel if there is an overlap.

When checking for overlaps, TimeLink goes back as far as the
beginning of the preceding year — an overlapping entry starting

three years ago, with a duration of ten years, will not be found. As
usual, you are free to type anything sensible in the Duration box, with
the following two rules to observe:

(i) the legal units are years, months, weeks, days, hours and
minutes;

(ii) you can only use two units in one entry - e.g. '1 hour 25
minutes' is okay, but 'l month 2 days 10 hours' uses three
different units and is read as 'l month 2 days'".

13
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If you do not enter a duration, TimeLink does not check for
overlapping entries. Durations appear in the Day window prefixed to
the entry. Thus the entry 'This is an entry' with a duration of 2
hours 45 minutes appears as '2 hr 45 min: This is an entry'. This
does not of course mean that the duration has become part of the
text. When you edit an entry using Change on the Update menu, the
duration is shown where you entered it - in the Duration box.
Remember; Duration is only available on the ST version.

¢ When you've finished the entry, click on the OK box to accept it.

When you have made a few entries, you can see the various ways they
appear in the four windows.

* In the Year window, just the first character of the key of the first
entry for the day is shown. If there is no key for that entry, the
first character of the text itself is displayed. This obviously makes
it useful for year-planning purposes to devise keys which begin
with different characters.

* The Month window gives the time, key and first few words of text
from the first entry for each day.

* The Week window shows more text, and three entries for each
day rather than one.

* The Day window shows the entire text of every entry for which
there is room.

If there are too many entries to be shown in the day and week
windows, small arrows appear on the right hand side of the window.
In the case of the Day window, the display is scrolled up by five
entries, or down to the next 'page' of entries. The Week window
works the same way, scrolling up or down by three entries at a time,
except that it is always the current day which is scrolled. The

current day is the one which is highlighted (shown in white on black
rather than black on white). This is important to remember when
using 'cur' or 'current' as a time entry: the current day being displayed
is not necessarily 'today'.

Try editing one of your entries. To do this,

¢ select the entry by clicking on it in one of the windows. When you've
done that correctly, the time of the entry is highlighted and you'll see
that the Change option in the Update menu is now enabled.

* Select this option and the entry is presented, ready for editing, in
the same dialogue box used for making a new entry.
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As a general rule, if you click on an entry, that entry becomes the
current entry and its time becomes the current time. If you click on a
position in the week, month or year window which has no entries in it,
you select a new current time, but there is now no current entry. The
Change and Delete options in the Update menu are only enabled when
there is a current entry to change or delete.

If you want to keep this file and begin a new file, select Close from the
File menu then New (or Load) to continue work on an existing file. You
should decide whether you want to use one large file for your entries or
smaller, individual files; e.g. personal and business entries.

When you have finished experimenting with your test file, you can leave
the program by selecting the Quit option from the File menu. This
automatically closes the file and makes sure that all the changes are
written to disk. NEVER LEAVE TIMELINK BY SWITCHING OFF THE
COMPUTER! This nearly always results in the data file being totally or
partially destroyed. At best, some of the entries you have made will be
lost and you must type them in again. The Quit command takes under
ten seconds to execute, so you don't save any time by living dangerously.

Remember to backup your data files or disks before you turn off your
computer.
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What Is An Entry?

This section gives you a more precise description of a TimeLink
entry. An entry is made up from the following parts:

Date and Time (to the nearest minute)

Key (up to seven characters)

Text (up to 241 characters, Macintosh)
(or 511 on the ST)

Duration (to the nearest minute; ST only)

The Date and Time (and Duration on the ST) are entered by you in
completely free format, as described above under 'Getting Started'.
If you do not enter the time of day, or type 'day' in the Time box, the
entry is taken to be a 'whole-day' entry which always appears before
other entries when displayed in the various windows.

There is a restriction on the range of dates that TimeLink handles.
Only dates between 1904 and 2039 (Macintosh) or 1980 to 2050
(ST) inclusive are valid. This restriction is caused by the use of the
standard Macintosh/GEM internal format for dates and times.

Note: for the inquisitive: on the Macintosh this is an unsigned 32-bit
number representing the number of seconds since midnight, 1st
January 1904.

Once you have made an entry with a particular time, that time is not
'taken' in any way. You can have a hundred entries all referring to
3:18 pm, Christmas Day 1999 if you like. Entries with the same
time appear on file in the order in which they were created.

The Key is a field for text entry up to seven characters long. It can
be used to distinguish different categories of entry within the same
file, in conjunction with the Key choice in the Select menu. You
need not enter a key, but if you leave it out you must enter some text
in the text box below: you can't have an appointment with no key and
no text.

The Text may be up to 241 (Macintosh) or 511 (ST) characters long,
and can include Return characters. Anything within square brackets
[like this] in the text can be scanned by the Sum numeric fields
function in the Extras menu: anything outside square brackets is
ignored by this function. See 'Extras', for more about this.
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(NOTE: ATARI ST).The Duration (ST only) is either blank, or
consists of either one or two quantity-plus-unit pairs. The quantity
can range from 1 to 8191, and the unit must be year, month, week,
day, hour or minute. Small units are not accumulated into larger
ones: if you enter a duration as 'l hour 100 minutes' it is stored as
such internally. However, if you enter two identical units they are
added together: '3 days 4 days' reappears (if, for example, you edit
an entry) as '7 days'.



Current Time...

Current Time, Current Entry and
Current Key

These three concepts in the chapter title determine what you see

on the screen in the Day, Week, Month and Year windows. There is
always a Current Time. When you start TimeLink up, this is set to
the real time taken from the clock built into the Macintosh or ST.
The Macintosh clock has a back-up battery, so it keeps good time
even when it is turned off. If you have a battery powered clock card
or cartridge for your ST, it should work the same and update the
time automatically. You can set the clock from the control panel,
which is one of the 'desk accessories' in the Apple (ST: DESK) menu
which always appears, whichever program is in use, at the left hand
end of the menu bar.

The day window always shows the day that includes the current
time. The week, month and year windows follow the same rule: the
area of time they cover always includes the current time. Therefore
these four windows can be thought of as a series of magnifying
glasses, of different powers, but all placed over the same underlying
picture. In the week, month and year windows (but not the day
window, since it is bound to show the current day) the day including
the current time is highlighted by making it white on black rather
than black on white.

You can select the current time by using the Date option in the
Select menu. This is the simplest method to use if the time you
want to get to is a long time from where you are. If not, there are a
variety of ways to move around:

e click on any part of the Day, Week, Month or Year window to move
to that time (if the part you click on is also part of an entry, it
becomes the current entry - see below);

e or click on the Previous day or Next day buttons in the day
window, or the similar buttons in the week, month and year
windows.

There is sometimes a Current entry. This is the entry which is
affected by the Change, Copy and Delete choices in the Update
menu. You cannot use any of these functions until you have selected
a current entry. If you have just added, changed or copied an entry,
the entry you worked on is automatically the current one. Otherwise
you can choose a current entry by moving the mouse pointer to the
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entry you want to select, and clicking the mouse button. If there is a
current entry, part of the entry itself is highlighted (the part giving
the time of day and key) as well as the Day-box next to it. If the
current entry appears in more than one window it is highlighted in
all the windows in which it appears.

File Edit Display Select Update Extras

SC0=————— Office example - May 1986
[rhul 1] e B zat]1?
Eril] 2 Sun|12
a 4: 00p Dirifer June Monl12| DAY Hol iday
Sun| 4 Tue|20
HMon|S Hed|21
Tue|& Thul22
Wed|? Fril23
Thul2 Sat|24
Fri|g Sun |25
Satf10 Mo |26
Sun|11[11:00am Church Tue|2?
Mon|12| 1:00pm Job _Interview Ued|ze8| DAY Birthday Party
Tu=|13 Thu|29
Hed|14 Fril|20
Thul|1s Sat|31
Frilig [ April ] ( June ]

Choose a current entry by clicking anywhere in the part of the window which
'belongs' to that entry.

Choosing a Current entry always sets the Current time to the time of
that entry. This means that if there is a current entry, it usually
appears on any of the Display windows which are visible. But note
that you may have to scroll the day and week windows up or down
using the arrows to find the current entry, and that the month
window always shows only the first entry for each day. A quick way

to look at the current entry is to choose Change from the Update
menu, then click the Cancel button when you have finished looking

at it.

There is always a Current key. This starts off as blank (ie: nothing)
when you start TimeLink up and so all entries are shown. If you
choose Key from the Select menu you can type in a new current key
and after that the windows show only entries with that key. To set
the current key to null' or blank again, choose Key and press the
backspace (Macintosh) or Esc (ST) key once (deleting the

highlighted text), then click on the OK button. If the Current key is
not null' the titles of the day, week, month and year windows show
this by having '(key = xxxx)' after their main titles. The same applies
to any report printed out using the Print command.
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NOTE: Every function except First free half-day (Macintosh) or First
free period (ST) is affected by the current key. This includes Sum
numeric fields and Print (plus Sum duration and Search for text on
the ST), which ignore any entries not matching the current key.

If you start up TimeLink, then open an existing file, the current
time, current entry if any, and current key is set to what they were
when that file was last in use. If you want the file to open on a
specific day next time you use it, select that day before you close the
file.
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Printing

The easiest way to get a quick hard copy of what you are currently
working on in TimeLink is to use the standard Control-key
sequences on the Macintosh or (NOTE: ATARI ST) Alt-Help on the
ST. This prints the screen or, on the Macintosh, the current
window only. Print functions differ considerably on the Macintosh
and ST. For that reason, this chapter is broken into separate
computer-specific sections.

NOTE: You can cancel printing by clicking on the Cancel button in
either of these two dialogue windows. Before you go ahead with the
print run, make sure the printer is turned on and connected to the
computer. This is one of the most common causes of the
phenomenon of the program mysteriously freezing at the moment
you expect the printing to start.

Macintosh Users

You can copy the entire screen to the printer by pressing the Caps-
lock key, holding down the Option and Shift keys together, then
pressing the 4 key. On European Macintosh keyboards the Option
key is the one with the 'cloverleaf junction' symbol on it, left of the
space bar. To copy just the front window to the printer, use the
same control key sequence - Option-Shift-4 - but without Caps-lock
being engaged.

These key sequences are standard and can be used in all Macintosh
programs. There is more detailed information about them in the
manual supplied with the computer.

Print entries over range:
start date: ll May J
end date: mdag

( 0K }‘} [ Ccancel ]

This window allows you to choose the range of dates spanned by the printed report.
As with all dates within TimeLink, you can use any of the shortcuts - like 'today’ -
available when adding a new entry.
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To print out any portion of a file in a neater format, use the Print
command in the File menu. When you do this a small window
appears at the top of the screen where you can specify the range of
dates over which you wish entries to be printed. After you have done
this there are two more dialogue windows allowing you to choose
things like the Quality (high quality, standard or draft) of the printed
report and how many Copies to print.

NOTE: You can cancel printing by clicking on the Cancel button in
any of these three dialogue windows. Before you go ahead with the
print run, make sure the printer is turned on and connected to the

computer.

If you are using high or standard quality printing, an image of the
printed page needs to be stored temporarily on disk. This can cause
problems if there is not enough disk space. If problems arise, try
making more space on the disk by deleting old files, or moving the
data file to a disk with nothing else on before printing it.

IMPORTANT NOTE: printing won't work unless the disk with the
data file on it also has the system file called Imagewriter. This file
contains all the standard printer driver routines. It can be copied
freely onto any disk where it is needed - you should find it in the
System Folder on any startup disk.

A Short Cut: to open a file and jump straight into the Print
command, click on the icon of the TimeLink data file, then choose
Print from the File menu in the Finder. If TimeLink is present it
starts up, opens the file, and goes into the printing sequence. After
printing, the file remains open for normal access and updating.

ST Users

To print out any portion of a file in a neater format than the screen
dump, use the Print command in the File menu. When you do this, a
larger window appears, giving you an opportunity to set your paper
length and width and edit your printer control codes, if necessary.

To produce neat reports TimeLink needs to know:

(i)  how to initialize the printer - that is, change it back to its
standard mode of operating, turning off any features like italics,
alternate character sets, or underlining;

(i) how to turn underlining on and off; and
(iii) how to turn bold face on or off. If your printer does not have

one or more of these facilities, simply clear the appropriate
editing box.



Printing

What is needed in each editing box in the 'Printer Control Codes'
section is a sequence of up to seven ASCII codes, each of which is a
decimal number (not a hexadecimal number) separated by a comma.
How is this derived from the information in the printer manual?
Let's use the 'initialize printer' sequence as an example. If you have,
say, an Epson FX-80 printer, page 3-64 of the manual contains the
information 'ESC @ - printer initialization'. The ASCII code for Esc
(‘escape’) is 27, while the code for the @ character (commercial at’)
is 64. So the edit box should contain '27,64' - which it already does,
since TimeLink is shipped with the printer control codes set up for
the Epson series of printers.

The length and width of the paper and the printer control codes
'stick' to the data file. This means that once you set them for a given
file you do not need to set them again unless you change printers.
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Extras

The Extras menu contains a variety of functions which add
immensely to the program's usefulness.

(NOTE: ATARI ST) The ST has several additional menu options not
available in the Macintosh version.

American date format on the Macintosh switches between the US
and UK ways of interpreting the date format '9/2/86', when typed in
by you in one of the dialogue windows, such as the Add new entry
window. If there is a tick next to this item in the menu (selecting

it), that date is taken to mean September 2nd 1986. If not, it is
understood as February 9th 1986. In addition, while American date
format is selected, dates appear in the format 'April 23 1986' rather
than 'April 23rd 1986'. When you choose this item on the menu, the
tick appears if it wasn't there before, or goes away if it was.

(NOTE: ATARI ST) On the ST, you have the option of selecting one
of three Date entry methods: MM/DD/YY, DD/MM/YY and
YY/MM/DD where DD is day, MM is month and YY is year. You can
also specify whether the suffixes 'st', nd' and 'rd' (as in 1st, 2nd
and 3rd) are appended to the day. The check mark beside the menu
item tells you which is selected.

Set Week one (or Week number on the ST) adjusts the week
numbering system so that the current day becomes the first day of
week one (or the specified week number on the ST) and the other
weeks are adjusted accordingly. This setting 'sticks' to the current
file so that you don't have to reset it every time you open the file.

[J==————=— Time between dates

[

Enter two dates (and times if needed):

iIsttime: [ | istdate: [IstMay8S ]
2nd time: [ | 2nd date: [25th Dec|8s |

7 months, 24 days (total 238 days)

Calculate N

Using the Time between dates window to calculate the time to Christmas.
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Time between dates calculates the time between any two dates
within the aliowed range (1904-2039 on the Macintosh, 1980-2050
on the ST). It gives the time in calendar years, calendar months,
days, hours and minutes and the total number of days and part-days.
Don't worry about the apparent discrepancy between the two
numbers of days. This occurs when you calculate the time between,
say lpm today and 10am tomorrow, which is shown as '0 days, 21
hours, O minutes (total 1 day). The total days is always the number
of calendar days between the two dates, which is at least one,
although the difference between the times of day makes the times
less than 24 hours apart.

[JE=———— Add or subtract time

Amount of time to add or subtract:

@ Add to:- O Subtract from:-
me: [ vate:  [moy 1, a9 G

Wednesday December 25 1985

( Calculate J

[ Use last result ] ((Make result current time |

Part of the Add or subtract time window.

Add or subtract time allows you to enter a starting date and add or
subtract any amount of time to it, using any variety of units you like.
There is no need to 'carry’ excess amounts of a given unit up to the
next one: you can add 1 year, 2 months, 3 weeks, 45 days, 67 hours
and 89 minutes if you wish. Years and months are 'calendar’ units:
adding ten years to a given date always brings you to the same day
and month, ten years hence. The result of the addition or
subtraction must be within the standard date range (1904-2039 on
the Macintosh, 1980-2050 on the ST).
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S[[==———= Sum numeric fields

Name or number of field: |EHD

start time: :I start date: WSHBS

end time: I:l end date: |todag J

Sum of Exp (2 items): 39.85

| Calculate |

Using the Sum numeric fields window to add up business expenses for the month.

Sum numeric fields allows you to sort your numeric data into any
number of categories, with names freely chosen by you, and add this
data up over any range of dates. If you wish a number in an entry to
be acessible to this function, put it inside square brackets [like this].
If you were logging business expenses, the best way to organise this
would be to make an entry for each expense, and put, somewhere in
the entry, an item like '[expense=$18.95]'. The word 'expense’ is

the Field name and can be anything you choose, provided it is made
up entirely of alphabetic characters.

When you use the Sum function, you can enter the field name and a
range of dates and all the entries in that range (and matching the
current key) are scanned for the field name and the first number
after it is added to the total. The scan ignores anything outside
square brackets, so only numbers you wish to be included are added
together. If you enter a number rather than a field name when
selecting the field to be totalled, this tells the sum function not to
look for a specific field name, but to take the n'th number in each
entry. This allows you if you wish to have a convention that within
certain types of entries the first number, say, refers to business
expenses and the second to car mileage, etc.

There is no limit to the number of numeric fields inside square
brackets in an entry, or to the length of a field name. Within a
particular entry, though, only the first number with a certain field
name is added to the total. Also, try to avoid nesting fields like
[number =[expense=2] 4].

Numeric fields must follow the following format: up to nine digits,
optionally followed by a fractional part. If present, the fractional part
must consist of a period (full stop) followed by up to nine digits.
Commas cannot occur within a number. Engineering and sciertific
notation (ie: 1E6 for 1000000) is not supported.
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Totalling is done by straight addition, with no rounding: full accuracy
is preserved. In the present version there is no check for

arithmetic overflow, which occur if the total exceeds 2147483647.
This is not thought to be overly restrictive in a program which is not
primarily a 'number-cruncher'.

File Edit Display Select Update Eutras

Office egample - Saturday May 3 1986
4 :00pm| Dinner June 1 :
ECJ=——= First free half-day ==———]
date: [May 4 1986 (am) B
keys: [Bill —|
((day before | [ day after )

I

This example shows the top left corner of the screen with the First free half-day
window on top of the Day window. As you can see, the following morning is the first
full half-day on which both June and Bill are free.

First free half-day (NOTE: ATARI ST)( First free period on the ST)
finds the first completely free half day (first completely free period

of the specified duration on the ST) after a certain date, for a list of
up to ten keys. The primary use for this is if you have organised your
file so that everyone in the office has a different key, most
conveniently his or her initials or first name (up to seven

characters). When you choose this function a window appears where
you can type in a starting date and a list of keys (on the ST there are
edit boxes to allow you to set the start and end times of day and you
can choose whether the search should include weekends). The keys
must be separated from each other by spaces, commas or other
punctuation. Each key must be made up completely from alphabetic
characters, or completely from numeric digits. You cannot mix

digits and numbers, or use symbols such as @ and *.
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Editing Text

Generally speaking, the text editing method follows the standard
Macintosh or GEM way of doing things. Nearly all the differences
are enhancements to make entering and editing text as easy as
possible on your particular computer.

There are two different types of edit box: single-line and multi-line.
All the edit boxes in TimeLink are single-line except for the Text

box in the Update window. In this edit box, the down-arrow and up-
arrow keys on the ST are used not for moving from one edit box to
the next but for moving up and down within the multi-line text. In
the Macintosh, use the mouse to position the cursor at the location
where you want to begin editing.

The only other difference between the two types is that in multi-line
editing the Return key is used to start a new line, while in a single-
line edit box Return is ignored.

You can always move the text cursor (the fine vertical line) to where
you want it by clicking the mouse at the desired point. You can move
between entry boxes by pressing the Tab key.

Double-clicking selects the word that the mouse is on, and
highlights it by displaying it in inverse - white on black rather than
black on white.

You can select a whole sentence - or any area of the text - by moving
the mouse to the start of the area and holding the mouse button
down while you move the mouse to the end of the area. This is
called 'dragging' over an area. To replace a section of text, select it
by dragging over it then just type the new text. To move a sentence,
drag over it, select Cut from the Edit menu, click on the place you
want the sentence to go, then select Paste from the Edit menu. If
you want to copy a sentence, use the same method, but select Copy
instead of Cut.

Any text that is cut or copied is placed in a file on disk called
'SCRAP.TXT in the ST or in the Clipboard on the Mac. When you
select Paste this material is read in from that source. This allows
other programs, such as SofTechnics' Rhythm, to interchange text
with TimeLink. Macintosh users can also copy text into the
Scrapbook.



32

Editing Text

(NOTE: ATARI ST) There are keyboard equivalents for the cut, copy
and paste commands on the ST: function keys F1, F2, and F3
respectively.

Here is a full list of editing commands:

Key

left arrow
(ST Only)

right arrow
(ST Only)

up arrow

(ST Only)

down arrow
(ST Only)

Tab

Esc

Backspace or Delete

(ST Only)

Return

mouse click

mouse double click

mouse 'drag’

Action

move the text cursor (the vertical
line) one character left.

move the text cursor one character
right.

move to the previous editing box, or,
if in the multi-line Text area, move
the text cursor up one line.

move to the next editing box (like
Tab) or, if in the Text area, move the
text cursor down one line.

move to the next editing box. This
can also be done with the mouse.

clear the current (ST only) editing
box

delete the character left of the text
cursor, or if a sequence of characters
has been selected, delete the
sequence (Mac).

(only works in the multi-line Text
area) move to a new line by inserting
a carriage-return in the text.

move the text cursor to where the
mouse was clicked.

select the word on which the mouse
was clicked.

(hold down the mouse button and
move the mouse) select the area of
text covered by the mouse. This area
is marked by inverting it to white on
black.



Editing Text

Cut (Edit menu) or F1
(ST

Copy (Edit menu) or F2
(ST)

Paste (Edit menu) or F3
(ST

Clear (Edit menu)
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cut out and save the currently
selected area.

copy the selected area.
paste the last area cut or copied back
into the text at the text cursor.

delete the currently selected area.
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SPECIAL NOTE

The following features are available on the
ST only

Search for text searches through the data file for the next entry,
after (and including) the current entry, which contains the text you
specify. If there is no current entry the search starts from the
current time. If the search is successful you 'move' to the entry that
was found and it becomes the current entry.

To avoid the possibility of very long fruitless searches, TimeLink
asks if you want to go on or abort the search every time a new year is
entered.

Sum duration adds up all the durations in entries which have the
current key (or have no key if none is selected) and fall between the
start and end dates you choose. This is very useful if, for instance,
you are a business consultant with several different clients. Simply
assign each client a different key, log your work under these keys,
using the duration field in all the entries and then see how much
time you have worked on Mr. Smith's case by setting the key to
'Smith' and using the 'Sum duration' facility.

When the summing is done, minutes are accumulated into hours and
months into years. Hours are not accumulated into days: this is
because work initially logged as amounts of hours is usually totalled
by hours rather than by days and hours. No other accumulation of
small units into larger ones is done, so be sure to decide on a
standard for recording time before creating a large TimeLink
database.
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TimeLink is flexibile enough to allow it to be useful in virtually any
time-based application. This section which describes three ways of
using TimeLink may help you see how to use the program to best
effect in your own field. By no means are these the only uses for
TimeLink; the variety of applications is limited only by your
imagination!

A Business Office

This is a simplified example of using TimeLink in an ordinary
business office with three people - Harry, Pete and Alice, all sharing
a single file. Any events concerning only one person are given a key
of that person's first name. Two other keys are in use - Exp (for
expenses) and meeting. Other keys can be added when they are
needed to handle necessary entries as they arise. Within Exp
entries, expenses for the three different people can be distinguished
if necessary by using three different field names: ExpAlice, ExpPete
and ExpHarry.

The Day window at the front shows an entry which has been
formatted on to several lines using Return characters to make it
clearer. This window was moved to the bottom of the screen so that
the Week window can be seen more clearly (NOTE: ATARI ST)(ST
users can also resize the window to display only the necessary
information area). In both windows the current entry is highlighted
by making it white on black instead of black on white.
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The Alarm Clock desk accessory (Macintosh only) has been selected
from the Apple symbol menu and moved to the top left corner of the
screen. Time and date can also be shown by selecting the control
panel accessory.

The user is just about to select Sum numeric fields from the Extras
menu, perhaps to total his or her expenses for the month.

File Edit Display Select Update Extras

Office edample - Week 16, 1986

Monday
April 14
lesdal g:00am[harry  [meeting to disuss new release
el 11:00am|pete exercise
April 15
Hednesday
April 16
alice [discuss wedding olans

O0ffice example - Thursday April 17 1986

PRl TPIRE-C d scuss wedding plans |

A Hairdressing Salon

This small hairdressers' has three employees: Sue, Anthea and Phil.
The appointments are entered simply by using the first names of the
employees as keys and then putting the customer's name and
requirements in the text of the entry.

File Edit Display [ Update Extras

Hairdressing example - Thursday May 9 1985

O Sham|Sue D _Spencer — cut
1O Ooam | Sue r=._ 1. _Crosland — tint
TT:00am[Anthea rs. J. Hrmstrong = trim
1T e . k. Harpisdn = tint
FRTT ~s. J. Saxby - perm
Fnthea M-, F . Gilbert — wash and cut

= S PR T = . Ealleq — usual
4: 00pm|Sue Hr=_ R Cherwell — perm

[ 0K ] [_Cancel_ )

[(dau before ] [ dau 4

In the Mac version, the user is just about to use the Select key
window to see Sue's appointments alone. This makes it much easier
to see exactly when Sue is free.
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pesk File Edit Display Select Update Extras
L B\EXAPLES\HAIR. TLK - Friday May 9 1986 [key = sue)

CROnror - rug

find first free period i

ThEn S ‘ ‘
Tt start tine: start date! [friday nay 9, 1986

period: (45 ninutes ]
start tine of day! end tine of day!
keys: [suef ]

11:38an, Friday Nay 9 1986

[ Find (any) | [ Find (veekday only! |
JETT L] S—— 4

(NOTE: ATARI ST).In the ST version, the user is just about to use
the Find first free period window to find out when Sue is next free
for a period of 45 minutes. Here the Find (weekday only) button is
used - Sue does not work on Saturday. The start and end times of
day are set to 9am and 5pm so that the time found is within her
working day.

A receptionist answering the phone to take appointments could
easily and quickly find out if a specific hairdresser was free for an
appointment and when the next free time was for each individual.
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A Running Diary
Two points are illustrated by this example. First, TimeLink can be
used to make a record of past events as well as keeping a schedule of
future ones. Second, TimeLink is a useful personal tool in the home
as well as a business program in the office. Personal entries can
easily be included in the same file as business entries but keyed
separately.

File Edit Display Select Update Extras

Running example - Sunday May 19 1985

M =TS 7 Tiee = 107) Farnning ot shrongTg ot ]
Bunninag examnle - lleek 20. 1985 1

—’_ Running example - May 1985

Ved] 1 [erili7] 2:30pm[HE (miles=5.2

[ |Thul 2 Sat|13
Fri|s sun|19| 7:00pm [B (miles = 15.7

H lsat| 4 o al & oneslue: (milas = &
Sun|s S[J=————— Sum numeric field

H | 5
2 Name or number of field Imiles ]
Tue|?

[ [Hed]8 start time: l:l start date: I]Sth May I
Thul g
Frilio endtime: [ | enddate: [24th May ]

[l |sat]11
Sunl12 [Sum of Miles (7 items): 56.1] ]
Mon|13

L Tue|14
ued|1s| 4.0d | Calculate

Thalial 2. n

This is part of the training diary of a runner. Each of the runs has
been given a key, such as HE, MH or HE2. The keys are mnemonic -

MH is 'Mill Hill' and refers to a route from the runner's house

to Mill Hill and back. Each entry has two numeric fields: miles and
time. A minor inconvenience is that time has to be given in minutes
and tenths of minutes, rather than minutes and seconds (e.g. 17.5 is
17 minutes, 30 seconds), or it would not add up properly.
Remember that numeric fields are not the same as time or date
fields.

Here the user is finding out his or her total training mileage over a
ten-day period. The Sum numeric fields window also shows that
this period includes seven runs. It would be quite easy to find out
the average speed in minutes per mile by totalling the time field and
dividing the sum by the total number of miles, which we already
have, using the Calculator, which can be chosen from the Apple
menu (Macintosh) or using a calculator accessory such as Rhythm
from the Desk menu (ST).
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It is a sad fact that disks do not last for ever. TimeLink files can be
copied like any other files, by dragging their icons with the mouse,
and you should make frequent backup copies of your working files
onto other disks. The simplest nearly foolproof backup scheme is as
follows:

e Make two backup disks, called, say 'Backup 1' and 'Backup 2".
Keep one next to the computer with your other disks, including
your working disk, and the other in a different room if possible.

e At the end of each day or long working session with TimeLink,
copy your working files from your work disk on to whichever of
the two backup disks is next to the computer. Then swap the
backup disks.

 Every few weeks, put the backup disks in a permanent archive
somewhere, marked with the date, and format two more fresh
backup disks. Format a new working disk and copy everything on
the old one to it, then archive the old work disk.

The reasoning behind this scheme is that:

() the latest backup is always in the next room, not next to the
computer where it would partake in any disaster (spilt coffee,
etc.) affecting the working disk;

(i) there are two backups, not one - essential to prevent the sort of
disaster caused if you were in the process of copying the files
from the work disk to your only backup, and if there were a
power fluctuation, destroying both disks; and

(iii) no disks are ever thrown away: if you loose both current
backups you can always go back to the latest archive disk, and
you need only re-enter information entered since the last
archiving.

If you run out of disk space at the moment of entering or changing
an entry, TimeLink lets you know of the problem and refuses to add
the entry to the file. You are able to continue working on the file
and everything else goes on working normally. You should quit and
remove any unnecessary files from the disk so that you can go on
adding to your TimeLink file, or copy the file to a new disk with
plenty of room.
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TimeLink has been carefully tested and should never crash under
normal circumstances. Any crashes which do occur are almost
certainly caused by power fluctuations or damaged disks. However,

it is the nature of writing computer programs of this size and
complexity that bugs can survive the most thorough testing. If you
think you have found one, please write to or call Batteries Included
giving as many details as you can. Your report will be taken seriously
and investigated. However, we are unable to accept any liability for
loss of data, or any losses consequential upon incorrect or lost data,
arising from the use of TimeLink.
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Reference - Timelink Functions
at a Glance

Macintosh Version:

Menu

Apple

File

Edit

Display

Select

Update

Extras

Choice

About TimeLink

others

New

Open...
Close
Print
Quit

Cut

Copy
Paste

Clear

Day
Week
Month
Year

Date
Key

Add new entry
Change entry

Copy entry

Delete entry

Time between dates

Result

display copyright notice and version
no.

perform standard desk accessory
functions

create a fresh, empty data file &
open it

open an existing TimeLink data file
close the currently open file

print data from current file

leave TimeLink and go back to the
Finder

remove and save selected text
take a copy of selected text

insert previously cut or copied text
delete selected text without saving
it

display day window
display week window
display month window
display year window

select new current date
select new current key

add a new entry to the current file
change the currently selected entry
create entry by changing existing
one

delete the currently selected entry

calculate time between two
dates
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Add or subtract time
Sum numeric fields
Set week one

American date format

Ranges and limits

Date range:
Entry size:

File size:
Entries in one file:

Entries in one day:
Numeric range:

Appendix 3 Reference

add or subtract time to/from
start time

sum any numeric field over any
range

set start of week one to current
day

toggle interpretation of date e.g.
6/7/89 is treated as June 7,
1989

Ist Jan 1904 ... 31st Dec 2039
text: 241 characters; key: 7
characters

file can be as big as can fit on the
disk

no limit

no limit

-2,147,483,648 ... 2,147,483,647



Appendix 3 Reference

ST Version:

Menu Choice

Desk About TimeLink
others

File New
Open...
Close
Print
Quit

Edit Cut
Copy
Paste
Clear

Display Day
Week
Month
Year

Select Date
Key

Update Add new entry
Change entry
Copy entry

Delete entry

Extras Time between dates
Add or subtract time
Sum numeric fields

Set week one

Result

display copyright notice & version
no.

standard desk accessory functions

create an empty data file & open it
open an existing TimeLink data file
close the currently open file

print data from current file

leave TimeLink & go back to
desktop

remove and save selected text
take a copy of selected text

insert previously cut or copied text
delete selected text without saving
it

display day window
display week window
display month window
display year window

select new current date
select new current key

add a new entry to the current file
change the currently selected entry
create entry by changing existing
one

delete the currently selected entry

calculate time between two
dates

add/subtract time to/from start
time

sum any numeric field over any
range

set start of week one to current
day
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54 Appendix3 Reference
MM/DD/YY toggle date entry method
DD//MM/YY . ! ! i
YY/DD/MM ! ; ; g
st/nd/rd toggle numeric suffix on (ie: 1st)
Find first free period find free period for up to 10
keys

Search for text move to next entry containing
the text

Sum duration sum durations over specified
range

Ranges and limits

Date range: Jan 1, 1980 ... Dec 31, 2050

Entry size: text: 511 characters; key: 7
characters

File size: file can be as big as can fit on the
disk

Entries in one file: no limit

Entries in one day: no limit

Free Memory - Clicking on 'About TimeLink' reveals the amount of
free memory.
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About SofTechnics and the
Author

SofTechnics is the business and home productivity division of one of
Great Britain's leading software publishers, SofTek International Ltd.
Founded in 1982, SofTek has been a market leader in Great Britain
in publishing both games and small business/home productivity
packages. They are one of the few British publishers who have
specialized in programming for the window/icon environments such
as the Macintosh, Atari ST, Amiga and GEM based micros.

SofTechnics is run by SofTek's president, Dr. Tim Langdell, who was
also partly responsible for the design of TimeLink. Dr. Langdell has
also been the president of Britain's 'Guild of Software Houses' and is
a director of Britain's 'Federation Against Software Theft'.

Graham Asher, program author of TimeLink, heads SofTechnic's
team of programmers and has been with the company for more than
a year as Chief Software Technician.






NEED HELP?

Having problems? Have you got questions about Batteries Included
software? Call the BI Customer Support Hotline. We'll be glad to help you
in any way we can. Because this is a free service we must ask that you
keep your questions brief and to the point. Since a limit of 5 minutes
of free service is permitted per call, prepare your query carefully and have
pertinent materials (e.g. your manual) on hand when you phone; there will
be an odditional charge for calls over five minutes. Our hours are
9am to 4pm (est), Monday to Friday. Best time to call — mormings .
Worst time to call — midday. If our lines are busy, please be patient. Do not
call our switchboard; they cannot patch you through or take messages
for customer support. If you would rather not phone, or your question or
problem is not urgent, please do write. We'll be glad to send you
a personal reply.

Please note:

Customer support is a free service for registered owners only.
Please make sure you have sent in your registration card.

Customer (416)

support 881-9816

30 Mural Street Richmond Hill Ontario Canada L4B IB5




The artistic standard for the ST!
Beautiful graphics program for
business and pleasure. All the
key draw/paint functions, text
integration and graphic design
tools!

Overall performance: Excellent
Graphics quality: Excellent
Ease of use: Easy

Value for money: Excellent
Documentation: Excellent
Error handling: Excellent

Family Computing

“D.E.G.A.S. manages to put
that computer’s (Atari 520 ST)
high tech hardware to work
for you with the kind of sophi-
sticated results that make you
ask, 'Did | really do that?”...
the potential for graphic cre-
ativity is enormous. D.E.G.A.S.
represents a lot of power

for a little money..."”

Kent A. Davenport, Family Computing

“...only one programmer had
managed to pull together a
full-featured paint program
that takes complete advantage
of the ST's fabulous graphics:
Tom Hudson. The program is

called D.E.G.A.S. and Bat-
teries Included has it. Congrat-
ulations to Tom Hudson and
Bl!...written on the ST, de-
signed on the ST, and uses

the ST like no program I've
seen...We don't have room to
describe all the D.E.G.A.S.
options...if you want the best
graphics package available for

the Atari 520 ST, get D.E.G.A.S..".

Jack Powell, Antic

“D.E.G.A.S. allows you to take
full advantage of your ST's
stunning graphics capability,
to produce nearly anything you
can imagine...” “Created spe-
cifically for the ST by Tom
Hudson, this is sure to become
an ST standard...”

Analog Computing

Also look for
D.E.G.A.S. Elite!

o
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Available for IBM, Macintosh,
Atari ST. Coming soon for
the Amiga.

® Designed by Lee Isgur,

one of the world’s top financial
analysts and first VP of
PaineWebber

@® GEM interface makes it easy
to operate — just point the cur-
sor at the command you want

® Update your portfolios with
the latest data from on-line
services — instant and accurate

® Telecommunications
module is pre-set to receive
Dow Jones, CompuServe, The
Source and InfoGlobe

® Package also includes [*S
Talk full-scale telecommunica-
tions program for those who
want to do more while on-line

® Powerful analytical features
include ‘Raise Money’, ‘Splits/
Dividends’, ‘Cash and Margins’,
‘Suppose’ and more

0S|

T H E 1 S G WR

"..gives serious investors many
of the technical analysis and
reporting tools used by profes-
sionals. It can handle many
investment portfolios simultan-
eously, consolidate multiple
portfolios of foreign currency
and allow automatic updating
of investments in different
portfolios.”

InfoWorld

"...actually three programs in
one. Memo pad and calendar
...portfolio management pro-
gram...and telecommunica-
tions program...extremely easy
to use...impressive extras.”
Personal Computing

"’..Itis dangerous to look at any
software package and say, ‘This
is the one,” but this one comes
very close.”

Computerized Investing
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ALSO

AVAILABLE
FOR YOUR
ATARI

Full-scale telecommunications
program. Easy to use and vir-
tually error-proof. Includes
50,000 word spelling checker
and three levels of macros.

® Multitude of exceptional
features are clearly organized
on GEM’s drop-down menus —
find the capability you need
fast

® Call up a help window for
every major function

® Exceptionally large capture
buffer — 300,000 possible bytes
in memory or unlimited if
spooled to disk

® Uses X-Modem protocol and
Kermit protocol

® Totally flexible data routing
to any combination of devices
— disk to modem, memory to
memory, screen to modem...

Three levels of macros

1. Comprehensive auto-dial
and auto log-on capabilities
provide totally automated
access to remote services

2. 'Keys’ macro associates any
text with a single keystroke —
use it to save time in entering
repetitive data or commands

3. ‘Replay” macro records any
complex sequence of opera-
tions — even an entire on-line
session for playback later

® Check the built-in I*S
Bridge Memo function for
messages from other systems
— or leave yourself memos
keyed to future dates




Available for Atari, Atari ST,
Commodore, IBM PC, PCjr,
Apple lle, ¢, Macintosh.

Three integrated programs on
one disk. Telecommunications.
Word-processor. Information
manager. The easy answer

to three key software needs.

1. HomeTerm Telecommunica-

tions Module 3. HomeFind Database Manager
® The simple way to get on- ® Streamlined information

line with public data-bases, management program you can
bulletin boards, other users learn quickly

® Extensive macro facility ® Natural English-language

data entry/retrieval system
® X-Modem protocol L) 4

® Includes all the key search/
sort functions, flexible queries,
simple output commands

@® Compatible with most pop-
lar modems

® Download files of virtually

| ; ) .
any length "“This three-in-one program is
® Save incoming text to disk, a bargain...one of the finest
or send directly to printer values on the market.”

Family Computing magazine

2. HomeText Word-Processor I ) :
!..inexpensive, powerful, in-

® Over 20 full-screen editing tegrated software. As such,

and formatting features HomePak is the winner of
InfoWorld's Best Buy Award.”

® Supports most printer InfoWorld magazine

functions including boldface,

underlining and extended "Quite simply the best.”

characters Analog Magazine

™
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THE WRITERS ASSISTANT

3 Powerful Writer's Tools
In One Program

Spelling Checker

A real-time 50,000 word spell-
ing checker. THUNDER! cor-
rects your spelling as you type
or corrects an entire document
when you‘ve finished. When
THUNDER! finds a spelling
error it will automatically

give you a list of alternate
words or spellings.

Speed-Typing Word Expander
and Corrector

Changes misspelled words,
abbreviations or short form
words to their correct spelling
automatically.

Sophisticated Writing Tools
THUNDER! provides you with
a detailed analysis of your
document, including word
count and your readability
score on the FOG and Flesch

POwLAFY
WRITERy
INONL PSRy

indexes. These widely-used
tests indicate how many years
of schooling an average
reader will need to under-
stand what you’ve written.

THUNDER! gives you a power-
ful, fully concurrent spelling
checker from within your fav-
ourite application programs.
Accuracy is way up, the time
you spend checking and cor-
recfing is way down.

THUNDER! is, of course,
compatible with: PaperClip
Elite, HomePak, BTS The
Spreadsheet and other pro-
grams from Batteries Included
and other software companies.

e \ |
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BatteryPak works with any
128K Macintosh and the new
Macintosh Plus! Also installs
on all hard disk drives.

Available for

Macintosh

“GRAND PRIZE
— and now the award
you've all been waiting for...
The Best Desk-Accessory-
Package Award goes to
BatteryPak.”

Sharon Zardetto Aker, A+ Magazine

“This calendar program far
surpasses Sidekick’s...Battery-
Pak’s modest price makes it an
aftractive purchase...a low-cost
utility system that Macintosh
users should seriously consider.”
Tom Neudecker, InfoWorld

"A Five Mouse Rating!
Batteries Included recently
jumped on the desk accessory
bandwagon; and to mix a met-
aphor, it seems to have landed
near the top of the heap..!’
Stephen Bobker, MacUser

“...all excellent desk accessor-
ies which you may find a need
for...the calendar and phone-
pad alone make the package
well worth the money.”

Gregg Keizer, Stephen Levy,
Compute!

THE MAC

"“BatteryPak concentrates on a
small number of important
functions: calendar, calculators,
operating system helpers,
phonedialerandprintspooling.
The bottom line is that they're
simple to use and get the job
done.”

Stephen A. Schwartz, MACazine

"I have no hesitation whatso-
ever inrecommending Battery-
Pak to anyone. Each of the in-
dividual desk accessories are
very well thought out and
implemented and the manual
is a delight to read and use.”
L.J. Kutten, Computer Shopper

"...The utility that we took an
immediate liking to is Disktools.
A remarkably simple tool which
can save you all those precious
rninutes quitting, dragging,
clicking and re-opening files!..""
Computer Entertainer
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BATTERIES INCLUDED

Atari

ST

Software

Integral Solutions

POrth]lO

.

DESIGN & ENTERUVINMENT GRAPHIC ARIN SN TEM

Iy Tom Hudson
The artistic standand for the ST! Beautiful eraphics
progeam for business and pleasure, Il the key drawing/
painting functions, lest istegration, and graphic
desion tools! Wailable: Now!

TUME LN~

Scheduling & Time-keeping tool for home and business.
Your day. week. month, year at a glance. VMany incredible
uses! Wailable: Now!

THUNDER!

[ se this unique real time spelling checker desk aceessory
within any ST GEV application. 50.000 word real time
spelling checker: \bbreviations function completes a word
when you enter the fust letters. Amazing speed.

Wailable: 3rd Quarter 1986.

Iy Russ Wetmore
O =\ D
o= a

STversion of Infolorld's Best Buy of the Year Award!
3integrated programs on one disk. Telecommunications.
Word-processor: Information manager. The easy answer Lo
three kev software needs. Available: 3rd Quarter 1986.

D= THE SPREADSHEET
BT

In Alan Porter; Martin Rezmer and Jason Loveman
‘™wo in one! Sophisticated full featured spreadsheet
program. Ml the key Math, Stats. Logical and Financial
functions. 1000 x 1000 worksheet. Plus Desk accessory
version on same disk! Available: 3rd Quarter 1986.

LonSitat

THE ultimate relational data base. Easy o learn. Unique
new features. Power and sophistication you can use right
awav. For business or personal use.

Wailable: 4th Quarter 1986.

Iy Vark
Skapinker

by the B Soltware
Development Team

IS TALK, TIVMIE & BILLING, PAPERCLIP ELITE, CONSULTANT,
DEGAS ELITE, DEGAS, PORTFOLIO, BTS SPREADSHEET HOMEPAK,
THUNDER AND B/GRAPH ARE ALL FILE COMPATIBLE, OF COURSE!

WRITE TO US FOR FULL COLOUR CATALOG OF OUR PRODUCTS FOR COMMODORE, ATARI, APPLE AND 1BM SYSTEMS. FOR TECHNICAL

SUPPORT OR PRODUCT INFORMATION PLEASE PHONE (416) 881-9816. 30 MURAL STREET, RICHMOND HILL, ONTARIO L48 185 CANADA,

(416) 881-9941, TELEX: 06-986-266. 17875 SKY PARK NORTH, SUITE P, IRVINE, CALIFORNIA, USA 92714, (416) 881-9816, Telex: 509-139. © 1986

BATTERIES INCLUDED. APPLE, ATARI, COMMODORE AND IBM ARE REGISTERED TRADEMARKS RESPECTIVELY OF APPLE COMPUTERS INC.,
COMMODORE BUSINESS MACHINES INC., AND 1BM BUSINESS MACHINES INC.

BATTERIES
INCLUDED

s v s 1 e wm Mark Skapinker
Investment management program designed for private
investors and professionals. On-line portfolio updating.
Analytical functions for more profitable decisions.

A PC Magazine editor’s choice! Available: Now!

TALK

Full-scale telecommunications program. Easy (o use and
virtually error-proof. Includes 50.000 word spelling checker
and three levels of macros. Available: Now!

“Ftite

\ext generation word-processor. All the high-productivity
features plus a real-time spell checker, idea processing,
integrated text/graphics, much more!

Available: 3rd Quarter 1986.

D& Gt

YRS ey 4 {144
£

by Stephen
Couchman

by Dan Moore
and Steve Ahlstrom

by Tom Hudson

Second-generation graphics program creates presentation-
quality visuals. Full range of design/color functions. Multiple
workscreens. new fonts. many other enhancements. The
deluxe Degas Elite is totally compatible with all other Degas
files! Integrate your Degas Elite pictures with PaperClip Elite
text files. Available: 3rd Quarter 1986.

5 G2 7

Serious graphics/charting and statistics desk package. Pie
charts, 2 and 3 dimensional bar charts, area graphs, much
more. Change designs withoul re-entering data. Make
beautiful presentations. Available: 4th Quarter 1986.

FS“M[ AND BILLING ko v

Office management program for professionals. Functions
include Dailv Records; Automatic Billing; Accounts
Receivable, Billing Breakdowns and more!

Available: 4th Quarter 1986.

by Alan Page.
Joe Chiazzese ¢
Robert Wilson
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BATTERIES INCLUDED

i EMNK

ATARI ST

WARNING: The programs contained on this disk are protected by
International Copyright laws. Duplication of these programs for other
than personal use is strictly forbidden and a violation of copyright laws.
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® TimeLink is a way of organ-
ising time-related information -
time management system or
‘temporal database’

m Timelink allows you to look at
your information in four different
ways. The day, week, month and
year windows provide various
views of the same information -
like having a personal secretary
make a new note on your wall-
chart year planner every time you
write an appointment in your
desk diary.

® call up any combination of diary
windows onto the screen at the
same time

minstant updating between time
frames - change a day, and that
change is automatically enteredin
your weekly, monthly and yearly
windows

8 “Add or Subtract Time” feature
helps you plan out projects with
confidence

® time planner doubles as a record-
keeping system - for example,
keeps track of billable hours for
invoicing customers

u jnstant andto-the-minute calcula-
tion of the time between any two
points — for example, the time you
spent working on an account

many information associated with
a time or date can be stored
- expenses, mileage, account
names and numbers, experi-
mental results ...

Fite Edit mw!oy Select Update Extras

(o) (swaie)

myser-defined searching/sorting
functions allow you to quickly
extract this embedded data and
Sum it over any time frame

mmax. file size: limited only by
disk space

mentries per file and entries per
day: virtually no limit

manyone who needs to know ex-
actly what's happening and when
® People who need to organise and
structure time. Secretaries;doctors
and dentists; club administrators
.— ANYBODY, in fact, who wants
to get at time-based information
quickly, accurately, and easily.
mone person can keep track of
meetings and commitments for
an entire office
madd in some of the program’s
database functions, and investors
can use it to chart their invest-
ments
mscientists can use it to log time-
sensitive experimental data
m engineering firms or construction
companies can map out the critical
path of complex projects
® and busy social calendars can now

- be easier to deal with
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